Characteristics of hypersomnia due to inflammatory demyelinating diseases of the central nervous system

Hideaki Ishido, Shigeru Chiba, Hana Takahashi, Megumi Isa, Yasuhiro Ogawa, Hiroki Kubota, Aya Imanishi, Yuki Omon, Taisuke Ono, Ko Tsutsui, GoEun Han, Hideaki Kondo, Hiroshi Tsuji, Kiyotaka Nakamagoe, Akiko Ishii, Keiko Tanaka, Akira Tamaoka, Tetsuo Shimizu, Seiji Nishino, Tomoyuki Miyamoto, Takashi Kanbayashi

ABSTRACT

Background Neuromyelitis optica spectrum disorder (NMOSD) diagnostic criteria for inflammatory demyelinating central nervous system diseases included symptomatic narcolepsy; however, no relevant case-control studies exist. We aimed to examine the relationship among cerebrospinal fluid orexin-A (CSF-OX) levels, cataplexy and diencephalic syndrome; determine risk factors for low- and intermediate-CSF-OX levels (≤200 pg/ml) and quantify hypothalamic intensity using MRI.

Methods This ancillary retrospective case-control study included 50 patients with hypersomnia and 68 controls (among 3000 patients) from Akita University, the University of Tsukuba and community hospitals (200 facilities). Outcomes were CSF-OX level and MRI hypothalamus-to-caudate-nucleus-intensity ratio. Risk factors were age, sex, hypersomnolence and MRI hypothalamus-to-caudate-nucleus-intensity ratio >130%. Logistic regression was performed for the association between the risk factors and CSF-OX levels ≤200 pg/ml.

Results The hypersomnia group (n=50) had significantly more cases of NMOSD (p<0.001), diencephalic syndrome (p=0.006), corticosteroid use (p=0.011), hypothalamic lesions (p<0.023) and early treatment (p<0.001). No cataplexy occurred. In the hypersomnia group, the median CSF-OX level was 160.5 (IQR 108.4–236.5) pg/ml and median MRI hypothalamus-to-caudate-nucleus-intensity ratio was 127.6% (IQR 115.3–149.1). Significant risk factors were hypersomnolence (adjusted OR (AOR) 6.95; 95% CI 2.64 to 18.29; p<0.001) and MRI hypothalamus-to-caudate-nucleus-intensity ratio >130% (AOR 6.33; 95% CI 1.18 to 34.09; p=0.03). The latter was less sensitive in predicting CSF-OX levels ≤200 pg/ml. Cases with MRI hypothalamus-to-caudate-nucleus-intensity ratio >130% had a higher rate of diencephalic syndrome (p<0.001, V=0.59).

Conclusions Considering orexin as reflected by CSF-OX levels and MRI hypothalamus-to-caudate-nucleus-intensity ratio may help diagnose hypersomnia with diencephalic syndrome.

INTRODUCTION

In 2009, hypersomnia with various events of diencephalic syndrome was reported in the autopsy report of a girl aged 17 years with neuromyelitis optica spectrum disorder (NMOSD): necrosis had been noted in her hypothalamus 21 months after disease onset. Thereafter, diencephalic syndrome and symptomatic narcolepsy were incorporated for the first time in the 2015 NMOSD diagnostic criteria for inflammatory demyelinating diseases of the central nervous system (IDDCNS). The category of diencephalic syndrome includes multihypothalamic dysfunction (ie, syndrome of inappropriate secretion of antidiuretic hormone, hypotension, abnormal body temperature, eating disorder, panhypopituitarism, amenorrhoea and memory impairment). Narcolepsy is a condition in which patients exhibit hypersomnia, characterised by excessive daytime sleepiness (EDS) (ie, unbearable daytime
sleepiness or falling asleep). The pathological hallmark of narcolepsy is impaired orexin function within the central nervous system, which has been associated with neurological disorders; therefore, cerebrospinal fluid orexin-A (hypocretin-1) concentrations (CSF-OX levels) are determined to aid in diagnosis. CSF-OX levels are classified as ≤110 pg/mL (low), >110 to ≤200 pg/mL (intermediate) and >200 pg/mL (normal). The diagnosis of narcolepsy in the International Classification of Sleep Disorders Third Edition is based on low CSF-OX levels. Diagnosis in the absence of CSF-OX levels requires rapid eye movement (REM) sleep abnormalities and the development of cataplexy and electrophysiological assessment using the multiple sleep latency test (MSLT).

Generally, hypersomnia caused by IDDCNS (eg, NMOSD) does not meet the ICSD-3 narcolepsy criteria, as it is classified as hypersomnia due to a medical disorder, which differs from EDS in idiopathic narcolepsy. It is characterised by excessive nocturnal sleep, EDS or excessive napping. Some key details remain unclear. First, cataplexy is often absent, except when associated with human leucocyte antigen (DQB1*06:02), which is typical of idiopathic narcolepsy. MSLT and polysomnography (PSG) are less frequently performed, and diencephalic syndrome tends to be more common; however, these findings are based on case reports. Second, hypersomnia due to medical disorders were reported in patients with hypersomnia15 and even those with intermediate CSF-OX levels, while decreased CSF-OX levels were not reported in patients with multiple sclerosis (MS). Thus, hypersomnia due to medical disorders cannot be characterised based on features specific to a single disease entity. Third, hypersomnia in IDDCNS has been associated with a high rate of hypothalamic lesions diagnosed using MRI. These findings have been qualitatively evaluated to be different from those associated with idiopathic narcolepsy; however, the relation between lesion severity and CSF-OX levels is unclear. Therefore, we conducted a case-control study to retrospectively examine the CSF-OX levels in patients with hypersomnia due to IDDCNS. We also aimed to assess the frequency of cataplexy and diencephalic syndrome and risk factors associated with low-and-intermediate CSF-OX levels, which are frequently reported in cases of hypersomnia due to medical disorders. Furthermore, we developed a method for quantifying hypothalamic intensity using MRI to identify factors associated with abnormal values.

METHODS
Study design and setting
This ancillary retrospective case-control study used existing CSF-OX data collected between 1 April 2000 and 31 December 2020. CSF-OX measurements were performed at Akita University until March 2019 and at the University of Tsukuba after April 2019. The number of patients, excluding duplicates, who underwent CSF-OX measurements was 3000; inpatients’ samples were collected from 200 facilities (community hospitals) in Asia.

Participants
We identified patients with hypersomnia and controls among patients with IDDCNS from the Akita University/University of Tsukuba databases based on the CSF-OX levels. Hypersomnolence was defined as excessive nocturnal sleep, EDS or excessive napping. Prolonged sleep time was defined as a total sleep time of ≥660 min during 24 hours, following the diagnostic criteria for idiopathic hypersomnia, based on the patient’s or family member’s report. As hypersomnolence and CSF-OX levels associated with IDDCNS tend to improve rapidly with early treatment, the hypersomnolence duration should be at least 24 hours when suspecting acute exacerbations as opposed to the duration of at least 3 months as specified by the ICSD-3. The control group included cases without hypersomnolence with acute exacerbation of core clinical characteristics (ie, optic neuritis, acute myelitis, area postrema syndrome, acute brainstem syndrome, diencephalic syndrome and symptomatic cerebral syndrome). IDDCNS included MS, NMOSD, myelin oligodendrocyte glycoprotein-antibody-associated disease (MOGAD) and acute disseminated encephalomyelitis (ADEM).

CSF samples were collected within 6 months of hypersomnolence onset before or during treatment. MRI data during the last 30 days before or after the CSF sample collection date and before or during treatment were analysed. The initial imaging method included T2-weighted two-dimensional fluid-attenuated inversion recovery (T2-weighted-2D FLAIR) or T2-weighted sequences, while the other method was diffusion-weighted imaging. Two types of imaging planes were available: an axial and a coronal. The slice thickness was <5 mm, magnetic field strength was ≥1.5 T, echo time was approximately 120 ms and repetition time was >10 000 ms.

The inclusion criteria for this study were confirmation or suspicion of IDDCNS (unclassifiable IDDCNS designated when autoantibody (eg, against aquaporin-4 or myelin oligodendrocyte glycoprotein) status was negative or untested, but the differential diagnosis could be excluded, and the diagnosis by the attending physician was IDDCNS (online supplemental table 1: cases 2, 6)), complete CSF and MRI data as described above and available follow-up information. The exclusion criteria were sleep disorders other than hypersomnia due to IDDCNS, primary hypersomnia, hypersomnia due to medications or substances, hypersomnia due to medical disorders other than IDDCNS, hypersomnia associated with psychiatric disorders, failure to meet the inclusion criteria and lack of follow-up information.

Data sources/data collection/measurements
The database consisted of the CSF-OX levels obtained according to the measurement protocol and responses to open-ended questions from attending physicians.
Questions regarding dates (ie, CSF sample collection, hypersomnolence and date of birth), sex, race, height, weight, diagnosis, core clinical characteristics, cataplexy, sleep paralysis, the Japanese version of the Epworth Sleepiness Scale, Expanded Disability Status Scale, treatments (eg, corticosteroids), time from treatment initiation, hypersomnolence duration, biochemical examination (eg, human leucocyte antigen (DQB1*06:02, DRB1*15:01)), MSLT (sleep latency, sleep-onset REM periods and REM latency) and PSG (total sleep time and sleep efficiency) were included. Data regarding patient name, diagnosis, hypersomnolence and CSF-OX levels in the spreadsheet were deleted and randomly assigned an identification number.

The follow-up cataplexy (observed until 31 December 2020) and MRI data were collected from 4 January to 31 July 2021. MRI data were anonymised by staff and given a specific identification number.

Two physicians performed the MRI analysis. The brain was divided into 23 regions for qualitative evaluation of lesions. The image analysis software Fiji was used to quantify intensity levels and is a plug-in of ImageJ (National Institutes of Health, Bethesda, Maryland, USA) commonly used for microscopic image analysis. The intensity was recorded as the luminance value per pixel (µm²). The data were processed via 8-bit grayscale conversion without segmentation and filtering. The procedure for measuring the intensity levels is described with reference to the Fiji screen in figure 1A. Identification and measurement of intensities of the hypothalamus and caudate nucleus were performed visually and manually, with the image enlarged to facilitate identification. The region of interest was required to be set at an appropriate distance from the CSF site to avoid interference of choroid plexus and CSF artefacts. We defined the MRI H/C ratio (%) as the intensity levels of the bilateral hypothalamus and caudate nucleus were performed visually and manually, with the image enlarged to facilitate identification. The region of interest was required to be set at an appropriate distance from the CSF site to avoid interference of choroid plexus and CSF artefacts. We defined the MRI H/C ratio (%) as the intensity levels of the bilateral hypothalamus and caudate nucleus relative to the bilateral caudate nucleus (figure 1B). The MRI H/C ratio (%) was calculated as follows: (mean intensity data of the hypothalamus)/(the mean intensity data of the caudate nucleus)×100. The results were recorded as the average of three measurements taken by two physicians. We modified a previously reported method that quantified intensity using ImageJ to standardise the caudate nucleus rather than the CSF. All measurements were performed on macOS 11 and 12 (Apple, Cupertino, California, USA).

**Outcomes**

The main outcome was the CSF-OX level, reflecting dysfunction of the orexin nervous system. The secondary outcome was the MRI H/C ratio.

**Statistical analysis**

Patient characteristics were described using the median and IQR for interval variables and numbers and percentages (%) for categorical variables. Differences in interval variables between the hypersomnia and control groups were analysed using the Mann-Whitney U test, and categorical variables were tested using Pearson’s χ² or Fisher’s exact test based on the expected frequency assumption. Bonferroni correction was performed by multiplying p values by 6, 11 and 23 for core clinical characteristics, treatments and brain MRI lesions, respectively. The correlation between the MRI H/C ratio and CSF-OX levels was analysed using Spearman’s rank correlation coefficients. The limit for detecting CSF-OX levels was defined as 40 pg/mL.

Binary logistic regression analysis was used to examine the association between the four risk factors (ie, age at onset >40 years, male sex, the occurrence of hypersomnia and an MRI H/C ratio >130%) and outcome (ie, low-and-intermediate CSF-OX levels). The variables in the model were entered using the forced entry method with no missing values. The sample size was estimated using Pearson’s χ² test and based on a previous study. Finally, with an expected dropout rate of 20%, 25 and 38 individuals were included in the hypersomnia and control groups, respectively (online supplemental figure 1).

Three subgroup analyses were performed. The first assessed the heterogeneity of CSF-OX levels at diagnosis. The second assessed heterogeneity of the frequency of diencephalic syndrome by combining qualitative data on hypothalamic lesions and quantitative MRI H/C >130% and ≤130% values. The third assessed heterogeneity of the frequency of diencephalic syndrome in the hypersomnia groups with low-and-intermediate and normal CSF-OX levels.

The statistical significance threshold was set at a two-sided p<0.05. All statistical analyses were performed using IBM SPSS Statistics V.28.0.0.0 (IBM, Armonk, New York, USA). Biostatisticians independently verified all analyses in this study.

**RESULTS**

Between 1 April 2000 and 31 December 2020, 3000 cases, excluding duplicates, were recorded. Of these, 114 cases of sleep disorders other than hypersomnia due to IDDCNS, 2137 of primary hypersomnia, 28 of use of hypersomnia medications or substances, 481 of hypersomnia due to medical disorders except IDDCNS, 100 of hypersomnia associated with psychiatric disorders, 2 where the differential diagnosis could not be excluded, 1 with the post-treatment CSF sample, 14 without MRI data and 5 with no information on cataplexy owing to
deaths were excluded. The remaining 118 patients were included in the current analysis (online supplemental figure 1). The median (IQR) age at onset was 39.4 (28.6–53.6) years; 12 (10.2%) patients were aged \( \leq 18 \) years, 85 (72.0%) were females and 115 (97.5%) were Japanese. The hypersomnia group (n=50) had significantly more age \( \leq 18 \) years (p=0.028), patients with NMOSD and ADEM (p<0.001) and diencephalic syndrome (p=0.006),

![Figure 1](image.png)

**Figure 1** Definition of the MRI hypothalamus-to-caudate-nucleus-intensity ratio. (A) Procedure for measuring the intensity levels. The Fiji screen is shown. The numbers indicate the steps. (1) Opening image files (File>Import>Image Sequence). (2) Processing the image before analysis: convert to 8-bit grayscale (Image>Type>8-bit). (3) Setting measurement items: select the mean gray value (Analyze>Set Measurements>Mean gray value (Mean)). (4) Designating and measuring the region of interest (ROI): select the segmented line (Area Selection Tools>Straight Line Selection Tool>Segmented Line) and view ROI manager (Analyze>Tools>ROI Manager). (5) Identifying and measuring the hypothalamus and caudate nucleus visually and manually, with the image enlarged to facilitate identification (Add>Measure). (6) Checking and saving the results. Permission was obtained for the images. (B) We defined the MRI hypothalamus-to-caudate-nucleus-intensity (MRI H/C) ratio (%) as the intensity level of the bilateral hypothalamus relative to that of the bilateral caudate nucleus. Quantification of the intensity levels was performed using the image analysis software Fiji. Data were processed via 8-bit grayscale conversion without segmentation and filtering. Identification and measurement of the hypothalamus and caudate nucleus were performed visually and manually by enlarging the images. The ROI was required to be set at an appropriate distance from the cerebrospinal fluid site to avoid interference of choroid plexus and cerebrospinal fluid artefacts. Anatomography was used to illustrate the location of the hypothalamus and caudate nucleus.
frequent corticosteroid therapy \(p=0.011\) and thalamic and hypothalamic lesions \(p<0.023\) and an earlier treatment initiation \(p<0.001\) than the control group. No cataplexy occurred \(p<0.001\) (table 1, online supplemental tables 1 and 2). The relationships between variables are described in online supplemental figures 2–4 and online supplemental table 3.

**CSF-OX levels and MRI H/C ratios in the hypersomnia group**

We obtained CSF-OX levels and MRI H/C ratios for the hypersomnia group. The median (IQR) CSF-OX level was 160.5 (108.4–236.5) pg/mL (ie, intermediate) in the hypersomnia group and 282.3 (216.3–371.7) pg/mL (ie, normal) in the control group \(p<0.001\). The median difference between the two groups was 43% \(p=0.011\) (figure 2, online supplemental table 4). Low CSF-OX level was found only in the hypersomnia group (online supplemental table 4). The median (IQR) MRI H/C ratio was 127.6% (115.3–149.1) in the hypersomnia group and 96.1% (88.3–105.0) in the control group \(p<0.001\) (online supplemental table 5).

### Table 1 Characteristics of the 118 patients with inflammatory demyelinating diseases of the central nervous system

<table>
<thead>
<tr>
<th>Variables</th>
<th>Hypersomnia (n=50)</th>
<th>Control (n=68)</th>
<th>P value*</th>
</tr>
</thead>
<tbody>
<tr>
<td>Age at onset, years</td>
<td>38.5 (21.0–50.3)</td>
<td>41.5 (30.3–54.5)</td>
<td>0.159</td>
</tr>
<tr>
<td>Age ≤18 years, no. (%)</td>
<td>9 (18.0)</td>
<td>3 (4.4)</td>
<td>0.028</td>
</tr>
<tr>
<td>Sex, no. (%)</td>
<td>40 (80.0)</td>
<td>45 (66.2)</td>
<td>0.098</td>
</tr>
<tr>
<td>Japanese, no. (%)</td>
<td>10 (20.0)</td>
<td>23 (33.8)</td>
<td>0.386</td>
</tr>
<tr>
<td>Diagnosis, no. (%)</td>
<td>48 (96.0)</td>
<td>67 (98.5)</td>
<td>0.023</td>
</tr>
<tr>
<td>NMOsD</td>
<td>33 (66.0)</td>
<td>10 (14.7)</td>
<td>&lt;0.001</td>
</tr>
<tr>
<td>MOGAD</td>
<td>5 (10.0)</td>
<td>3 (4.4)</td>
<td></td>
</tr>
<tr>
<td>MS</td>
<td>6 (12.0)</td>
<td>55 (80.9)</td>
<td></td>
</tr>
<tr>
<td>ADEM</td>
<td>4 (8.0)</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>Unclassifiable IDDCNS†</td>
<td>2 (4.0)</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>Core clinical characteristics, no. (%)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Diencephalic syndrome</td>
<td>20 (40.0)</td>
<td>0</td>
<td>0.006</td>
</tr>
<tr>
<td>Hypersomnolence, no. (%)</td>
<td>50 (100.0)</td>
<td>0</td>
<td>NA</td>
</tr>
<tr>
<td>Cataplexy, no. (%)</td>
<td>0</td>
<td>0</td>
<td>NA</td>
</tr>
<tr>
<td>Treatments, no. (%)</td>
<td>49 (98.0)</td>
<td>41 (60.3)</td>
<td>0.011</td>
</tr>
<tr>
<td>Time from treatment initiation, years</td>
<td>0.1 (0–0.2)</td>
<td>2.2 (0.3–7.4)</td>
<td>&lt;0.001</td>
</tr>
<tr>
<td>Brain MRI lesions, no. (%)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Caudate nucleus</td>
<td>2 (4.0)</td>
<td>0</td>
<td>&gt;0.99</td>
</tr>
<tr>
<td>Thalamus</td>
<td>27 (54.0)</td>
<td>1 (1.5)</td>
<td>0.023</td>
</tr>
<tr>
<td>Hypothalamus</td>
<td>45 (90.0)</td>
<td>0</td>
<td>0.023</td>
</tr>
</tbody>
</table>

Data are presented using the median and IQR for interval variables and numbers and percentages (%) for categorical variables. *P values were calculated using Pearson’s \(\chi^2\) test or Fisher’s exact test for categorical variables and the Mann-Whitney U test for interval variables. The threshold for statistical significance was two-sided \(p<0.05\). Bonferroni correction was used for core clinical characteristics by multiplying p values with 6, for corticosteroid therapy by multiplying p values with 11 and for brain MRI lesions by multiplying p values with 23.

†Unclassifiable IDDCNS: autoantibody (eg, against aquaporin-4 or myelin oligodendrocyte glycoprotein) status was negative or untested, but the differential diagnosis could be excluded.

ADEM, acute disseminated encephalomyelitis; IDDCNS, inflammatory demyelinating diseases of the central nervous system; MOGAD, myelin oligodendrocyte glycoprotein-antibody-associated disease; MS, multiple sclerosis; NA, not assessed; NMOsD, neuromyelitis optica spectrum disorder.
Risk factors associated with low-and-intermediate CSF-OX levels

We explored risk factors associated with low-and-intermediate CSF-OX levels. The coefficients of association between the four risk factors are listed in online supplemental figure 5. Occurrence of hypersomnolence (adjusted OR=6.95; 95% CI (CI)=2.64–18.29; p<0.001) and an MRI H/C ratio >130% (adjusted OR 6.33; 95% CI 1.18 to 34.09; p=0.032) were significantly associated with low-and-intermediate CSF-OX levels (table 2), while an MRI H/C ratio >130% was less sensitive in predicting CSF-OX levels ≤200 pg/mL (online supplemental figure 6). The results of the Hosmer-Lemeshow test as a goodness-of-fit test were not significant (χ² value 11.37; p=0.078). There were no covariate patterns with standardised Pearson’s residuals >2.0 and no outliers. Additionally, no multicollinearity of covariates was observed with a tolerance >0.2 and a variance inflation factor <5 (online supplemental table 6).

Results of subgroup analyses

We evaluated the differences in CSF-OX levels and MRI H/C ratios between the subgroups. CSF-OX levels did not differ according to the diagnosis in the hypersomnia group after Bonferroni correction (figure 4). Of the 45 patients with qualitative hypothalamic lesions, 20 had quantitative hypothalamic lesions (ie, MRI H/C ratios >130%) (online supplemental table 7). Patients with MRI H/C ratios >130% with qualitative hypothalamic lesions had a significantly higher rate of diencephalic syndrome complications (p<0.001, V=0.59) than those without (online supplemental table 7). The hypersomnia group with low-and-intermediate CSF-OX levels had a significantly higher frequency of diencephalic syndrome (p=0.003, Φ=0.42) than the hypersomnia group with normal CSF-OX levels (online supplemental table 8).

DISCUSSION

The hypersomnia group had a higher frequency of diencephalic syndrome and hypothalamic lesions and an earlier start of treatment than the control group. The hypersomnia group had intermediate CSF-OX levels and higher MRI H/C ratios than the control group. The risk factors associated with low-and-intermediate CSF-OX levels were the occurrence of hypersomnolence and an MRI H/C ratio >130%, while an MRI H/C ratio >130% was less sensitive in predicting CSF-OX levels ≤200 pg/mL.

We observed a difference in the time from treatment initiation. For patients with idiopathic narcolepsy, this period was 14.63 (14.31) years, whereas it was 0.1 (0–0.2) years for those with hypersomnia. Cataplexy is the hallmark symptom of narcolepsy, and it is triggered by an abrupt transition from arousal to REM sleep. Chronic orexin deficiency is assumed to involve cataplexy expression. Autopsy reports of patients with idiopathic narcolepsy with cataplexy showed orexin-expressing neuron loss rates >85%–90%. After a 10-year follow-up of 127 patients with idiopathic narcolepsy without cataplexy, 10% of patients in the low CFS-OX group exhibited cataplexy, whereas after 9.5 (5.5–12.6) years of posttreatment follow-ups, none of the 12 patients in the low CSF-OX group exhibited cataplexy (online supplemental table 1). In patients with hypersomnia due to IDDCNS, damage to the orexin neurons localises in the lateral hypothalamic nucleus, and the time to treatment initiation is short. Furthermore, 98% of patients in our study were treated with corticosteroids, likely in the absence of a chronic orexin-deficient state. Therefore, recovery of CSF-OX levels was observed during post-treatment monitoring (online supplemental table 1: cases 1, 2, 10, 12). The consideration of orexin levels and MRI quantification, pathology and qualitative MRI allowed us to identify an association with diencephalic syndrome. CSF-OX levels reflect the degree of injury to orexin neurons localised in the lateral hypothalamus. Conversely, the diencephalic syndrome associated with IDDCNS present with diverse symptoms due to extensive and intense hypothalamic injury. MRI is suitable for capturing a wide range of injuries. Furthermore, other studies have suggested that neuroimaging using T2-weighted-2D FLAIR reflects the pathogenesis of acute IDDCNS. Conversely, in a patient who presented with hypersomnolence and diencephalic syndrome and was diagnosed postmortem with NMOSD, hypothalamic lesions 21 months from onset showed necrosis that could...
not be immunostained by pathology, but MRI imaging abnormalities were not prominent.\(^1\) On retracing the history, pathological gliosis at 8 months from onset was reflected as an abnormal MRI signal. Here, patients with MRI H/C ratios >130% also indicated significantly higher complication rates for diencephalic syndrome (p<0.001, \(\Phi=0.59\)) (online supplemental table 7). Moreover, the hypersomnia group with low- and intermediate CSF-OX levels had a significantly higher frequency of diencephalic syndrome (p=0.003, \(\Phi=0.42\)) than did the hypersomnia group with normal CSF-OX levels (online supplemental table 8). Furthermore, we demonstrated that MRI intensity is indistinguishable between necrotic and normal tissues with an equal signal (figure 3). Therefore, the combination of MRI H/C ratios and CSF-OX levels can indicate patients with hypersomnia due to IDDCNS with diencephalic syndrome requiring rigorous treatment. Furthermore, our results support those of a recent study,\(^15\) indicating that intermediate CSF-OX levels

Figure 3  Correlation between the MRI hypothalamus-to-caudate-nucleus-intensity ratios and cerebrospinal fluid orexin-A (CSF-OX) levels. (A) Correlogram with dots representing individual cases projected by the MRI hypothalamus-to-caudate-nucleus-intensity (MRI H/C) ratios (x-axis) and the CSF-OX (hypocretin-1) levels (y-axis). Filled dots indicate the hypersomnia group; unfilled dots indicate the control group. The MRI H/C ratio is a quantified index of hypothalamic intensity data based on the caudate nucleus (figure 1). A significant negative correlation was observed between the MRI H/C ratio and CSF-OX levels (\(\rho=-0.42, p<0.001\)). Asterisks indicate cases with representative brain MRI data (a, control; b–f, hypersomnia). (B) Representative T2-weighted fluid-attenuated inversion recovery MRI of the brain in patients from two MRI H/C ratio categories and three CSF-OX level categories: MRI H/C ratio >130%, MRI H/C ratio \(\leq 130\%\), low CSF-OX level (\(\leq 110 \text{ pg/mL}\)), intermediate CSF-OX level (>110 to <200 pg/mL) and normal CSF-OX level (>200 pg/mL). a, Multiple sclerosis (MS), CSF-OX level 238.1 pg/mL, and MRI H/C ratio 115.0%. b, Neuromyelitis optica spectrum disorder (NMOSD), CSF-OX level 345.0 pg/mL, and MRI H/C ratio 147.8%. c, Acute disseminated encephalomyelitis, CSF-OX level 177.0 pg/mL and MRI H/C ratio 121.4%. d, MS, CSF-OX level 152.0 pg/mL and MRI H/C ratio 166.2%. e, NMOSD, CSF-OX level 20.9 pg/mL and MRI H/C ratio 122.6%. f, Myelin oligodendrocyte glycoprotein-antibody-associated disease, CSF-OX level 75.0 pg/mL and MRI H/C ratio 206.5%. Permission was obtained for all the images.
may also be abnormal in patients with symptomatic hypersomnia. We found that the median CSF-OX level in the hypersomnia group was intermediate at 160.5 pg/mL (figure 2). Patients with hypersomnia had a higher likelihood of low-and-intermediate CSF-OX levels than the controls. CSF-OX levels are normal in those with idiopathic hypersomnia, the pathophysiology of which may differ from that of idiopathic narcolepsy. The pathogenesis of hypersomnia due to IDDCNS may be similar to that of idiopathic hypersomnia, even though the CSF-OX levels may differ and are often intermediate. Finally, we found no difference in the heterogeneity of CSF-OX levels at diagnosis in patients with hypersomnia due to IDDCNS (figure 4).

A negative finding of this study is that an MRI H/C ratio >130%, one of the risk factors associated with low-and-intermediate CSF-OX levels, is less sensitive to predict CSF-OX levels ≤200 pg/mL (online supplemental figure 6). Some patients develop hypersomnia despite normal CSF-OX levels; additionally, there is no hypersomnolence despite intermediate CSF-OX levels. Lastly, MRI intensity is indistinguishable between necrotic and normal tissues with an equal signal. Therefore, we tested the validity of the MRI H/C ratio (table 3). The MRI H/C ratio showed variability in results in the absence of hypothalamic lesions but adequately reflected the intensity in the presence of lesions. We made two major innovations. In the former, we set a cut-off value for the MRI H/C ratio in advance. The MRI H/C ratio >130% is based on the % difference ≤30% of medical displays with uniform luminance. Normal tissue and lesion areas were assumed to have a % difference of >30% due to non-uniformity of luminance. The latter is a protocol modification from a previous study that quantified intensities using ImageJ to standardise the caudate nucleus rather than the CSF. The CSF pulsation is also an artefact; thus, the anatomical conditions were aligned around the ventricles. Additionally, caudate nucleus lesions are not specific for IDDCNS in adults. Furthermore, the caudate nucleus is not a direct input/output site for orexin neurons in rats.

In our study, 78% of the hypersomnia group only had hypersomnolence, and 96% visited physicians or medical institutions that did not specialise in sleep medicine (online supplemental table 2). The large and diverse sample of this study makes the results easily applicable in clinical practice. Existing data were used, and no new medical resources were required. T2-weighted-2D FLAIR used in routine examinations to diagnose IDDCNS. Moreover, Fiji is a free, highly reliable and publicly available software developed by the National Institutes of Health.

**Limitations**

First, two cases of unclassifiable diagnoses were included in the analysis, which may have caused selection bias. However, there was no significant difference in the results after excluding their data. Second, iron deposition in the caudate nucleus can occur in MS, which may affect the MRI H/C ratio. However, there were no differences in the MRI H/C ratios in the control group based on the presence of caudate nucleus lesions.

<table>
<thead>
<tr>
<th>Table 2</th>
<th>Factors associated with CSF-OX levels ≤200 pg/mL in the 118 patients with inflammatory demyelinating diseases of the central nervous system</th>
</tr>
</thead>
<tbody>
<tr>
<td>Variables</td>
<td>CSF-OX levels, pg/mL</td>
</tr>
<tr>
<td></td>
<td>≤200 (n=48)</td>
</tr>
<tr>
<td>Age at onset, years</td>
<td></td>
</tr>
<tr>
<td>≤40</td>
<td>27 (56.3)</td>
</tr>
<tr>
<td>&gt;40</td>
<td>21 (43.7)</td>
</tr>
<tr>
<td>Sex</td>
<td></td>
</tr>
<tr>
<td>Female</td>
<td>37 (77.1)</td>
</tr>
<tr>
<td>Male</td>
<td>11 (22.9)</td>
</tr>
<tr>
<td>Hypersomnolence</td>
<td></td>
</tr>
<tr>
<td>Without</td>
<td>12 (25.0)</td>
</tr>
<tr>
<td>With</td>
<td>36 (75.0)</td>
</tr>
<tr>
<td>MRI H/C ratio, %</td>
<td></td>
</tr>
<tr>
<td>≤130</td>
<td>31 (64.6)</td>
</tr>
<tr>
<td>&gt;130</td>
<td>17 (35.4)</td>
</tr>
</tbody>
</table>

Binary logistic regression analysis was used to examine the association of CSF-OX (hypocretin-1) levels ≤200 pg/mL (low and intermediate groups) with four risk factors as covariates: age at onset >40 years, male sex, hypersomnolence and MRI H/C ratio >130%. The Hosmer-Lemeshow test results were non-significant. There were no covariate patterns with standardised Pearson's residuals >2.0, no outliers and no multicollinearity among the covariates.

CSF-OX, cerebrospinal fluid orexin-A; MRI H/C ratio, MRI hypothalamus-to-caudate-nucleus-intensity-ratio; NA, not assessed.
CONCLUSION
We found that patients with hypersomnia due to IDDCNS included more NMOSD cases and cases with intermediate CSF-OX levels than the controls. Notably, no cases of cataplexy were observed in patients with hypersomnia due to IDDCNS, in contrast to typical findings in cases of idiopathic narcolepsy. The results suggest that the combination of MRI H/C ratios and CSF-OX levels can be applied to detect hypersomnia with diencephalic syndrome.

Figure 4 Violin plots of cerebrospinal fluid orexin-A (CSF-ox) levels by diagnosis for 50 patients with hypersomnia and 68 control patients with inflammatory demyelinating diseases of the central nervous system. Panels A and B show the results of the hypersomnia group and the control group, respectively. The x-axis indicates the central nervous system, and the y-axis indicates CSF-ox levels. The thick lines indicate the medians, and the thin lines indicate the interquartile ranges (IQRs). The limit for detecting CSF-ox levels was defined as 40 pg/mL. Unclassifiable inflammatory demyelinating diseases of the central nervous system: autoantibody (e.g., against aquaporin-4 or myelin oligodendrocyte glycoprotein) status was negative or untested, but the differential diagnosis could be excluded.

Table 3 Validation of the MRI hypothalamus-to-caudate-nucleus-intensity ratio

<table>
<thead>
<tr>
<th>Variables</th>
<th>Hypersomnia (n=50)</th>
<th>Control (n=68)</th>
<th>Narcolepsy (n=10)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Age at onset, years</td>
<td>38.5 (21.0–50.3)</td>
<td>41.5 (30.3–54.5)</td>
<td>33.0 (23.0–36.5)</td>
</tr>
<tr>
<td>Sex, no. (%)</td>
<td>Female 40 (80.0)</td>
<td>NA</td>
<td>Female 5 (50.0)</td>
</tr>
<tr>
<td></td>
<td>Male 10 (20.0)</td>
<td>NA</td>
<td>Male 5 (50.0)</td>
</tr>
<tr>
<td>Body mass index, kg/m², (n)</td>
<td>20.6 (18.2–24.7) (n=41)</td>
<td>NA</td>
<td>23.7 (21.5–26.3) (n=57)</td>
</tr>
<tr>
<td>MRI H/C ratio, %</td>
<td>127.6 (115.3–49.1)</td>
<td>127.9 (117.7–150.3)</td>
<td>96.1 (88.3–105.0)</td>
</tr>
</tbody>
</table>

Data are presented using the median and IQR for interval variables and numbers and percentages (%) for categorical variables. *P values were calculated using the Wilcoxon signed-rank test for the MRI H/C ratio. †P values were calculated using Pearson’s χ² test for categorical variables and the Kruskal-Wallis H test for interval variables after Bonferroni correction. The threshold for statistical significance was two-sided p<0.05. ‡The number of patients is shown in brackets. We randomly selected MRI data of 10 patients with idiopathic narcolepsy whose structural MRI findings were considered normal from the databases of 3000 CSF-ox levels. The MRI H/C ratio was measured for 120 blinded patients, and the mean of three measurements by two physicians was used. There was no difference in MRI H/C ratios between the control and idiopathic narcolepsy groups (p=0.001). Furthermore, the hypersomnia group showed no difference between the present and validation studies (p=0.460), while the control group showed a significant difference (p<0.001). There were no differences in p values after Bonferroni correction for age at onset among the three groups.

CSF-ox, cerebrospinal fluid orexin-A; MRI H/C ratio, MRI hypothalamus-to-caudate-nucleus-intensity ratio; NA, not assessed.
Further validation of the MRI H/C ratio in additional IDD CNS cases is needed in the future.

**Author affiliations**

1 International Institute for Integrative Sleep Medicine (WPI-IIIS), University of Tsukuba, Tsukuba, Ibaraki, Japan
2 Neurology, Dokkyo Ika Daigaku Saitama Iryo Center, Koshigaya, Saitama, Japan
3 Neurology, Hokusuikei Hatsushii Hospital, Kashiwa, Chiba, Japan
4 Psychiatry, Ibaraki Prefectural Medical Center of Psychiatry, Kasama, Ibaraki, Japan
5 Psychiatry, Minamisaitama Hospital, Koshigaya, Saitama, Japan
6 Neurology, University of Tsukuba, Tsukuba, Ibaraki, Japan
7 Neurology, National Defense Medical College, Tokorozawa, Saitama, Japan
8 General Medicine, Ibaraki Prefectural University of Health Sciences, Inashiki-gun, Ibaraki, Japan
9 Pediatrics, Akita University, Akita, Akita, Japan
10 Psychiatry, Akita University, Akita, Akita, Japan
11 Psychiatry, Tokyo Metropolitan Geriatric Hospital, Itabashi-ku, Tokyo, Japan
12 General Medicine, Kanto Medical Research Institute, Koshigaya, Japan
13 Department of Animal Model Development, Brain Research Institute, Niigata University, Niigata, Niigata, Japan
14 General Medicine, Institute of Biomedical Sciences, Nagasaki University, Nagasaki, Nagasaki, Japan
15 Department of Animal Model Development, Brain Research Institute, Niigata University, Niigata, Niigata, Japan
16 Neurology, Tsukuba Memorial Hospital, Tsukuba, Ibaraki, Japan
17 Department of Mental Health and Welfare, Akita Mental Health and Welfare Center, Akita, Akita, Japan
18 Psychiatry, Sleep and Circadian Neurobiology Laboratory, Stanford University, Stanford, California, USA

**Acknowledgements** Kensaku Morii (Department of Radiology, University of Tsukuba) provided advice and suggested methods for validating the MRI data. We sincerely thank Dr. Kimikono Kaneko (Department of Neurology, Tohoku University Graduate School of Medicine) and Dr. Toshiyuki Takahashi (Department of Neurology, Tohoku University Graduate School of Medicine and National Hospital Organization Yonezawa National Hospital) for the MOG antibody results. We would like to thank Yoko Irukayama (International Institute for Integrative Sleep Medicine (WPI-IIIS), University of Tsukuba) for her assistance in entering data into the database and anonymising the MRI data. We would like to acknowledge Akemi Nakayama, Kyoko Kato and Masako Ishido (International Institute for Integrative Sleep Medicine (WPI-IIIS), University of Tsukuba) for their assistance in facilitating smooth communication with external institutions.

**Contributors** Conception and design of this study; all authors. Acquisition and interpretation of data: all authors. Statistical analysis: Hi and GEH. Drafting and significant revisions of the manuscript: all authors. All authors commented on this manuscript and approved the final version to be submitted. All authors agreed to be accountable for all aspects of the work. TK is the guarantor.

**Funding** The supplies needed for this study (eg, statistical software, journals and reference books) were supported by grants from Dokkyo Medical University (Young Investigator Award 2021–19 to Hi), the Japan Agency for Medical Research and Development (AMED) (grant nos. JP19dm098001, JP20dm017162 and JP21zf0127005 to TK), and JSPS KAKENHI (Grant-in-Aid for Scientific Research (C) 19K00837 to TK).

**Competing interests** Hi has received grants from Dokkyo Medical University (Young Investigator Award 2021-19), TK has received AMED (grant nos. JP19dm008001, JP20dm017162 and JP21zf0127005) and JSPS KAKENHI (Grant-in-Aid for Scientific Research (C) 19K00837). Kta has received payment of honoraria for lectures, presentations, speakers’ bureaus, manuscript writing or educational events from Sumitomo Pharma and EUROIMMUN Japan in the past 36 months.

**Patient consent for publication** Consent obtained directly from patient(s).

**Ethics approval** The Ethics Committees (Clinical Research Ethics Review Committee, University of Tsukuba Hospital, R01-122, R03-109 and Certified Clinical Research Review Board, Akita University, 768) approved this study. This study complied with the guidelines of Strengthening the Reporting of Observational Studies in Epidemiology and the Declaration of Helsinki. Participants gave informed consent to participate in the study before taking part. Consent for the six cases with MRI findings was also obtained.

**Provenance and peer review** Not commissioned; externally peer reviewed.

**Data availability statement** Data are available on reasonable request. CSF-0X levels for all anonymised patients are available to any qualified researcher on request to the corresponding author.

**Supplemental material** This content has been supplied by the author(s). It has not been vetted by BMJ Publishing Group Limited (BMJ) and may not have been peer-reviewed. Any opinions or recommendations discussed are solely those of the author(s) and are not endorsed by BMJ. BMJ disclaims all liability and responsibility arising from any reliance placed on the content. Where the content includes any translated material, BMJ does not warrant the accuracy and reliability of the translations (including but not limited to local regulations, clinical guidelines, terminology, drug names and drug dosages), and is not responsible for any error and/or omissions arising from translation and adaptation or otherwise.

**Open access** This is an open access article distributed in accordance with the Creative Commons Attribution Non Commercial (CC BY-NC 4.0) license, which permits others to distribute, remix, adapt, build upon this work non-commercially, and license their derivative works on different terms, provided the original work is properly cited, appropriate credit is given, any changes made indicated, and the use is non-commercial. See: http://creativecommons.org/licenses/by-nc/4.0/.

**ORCID iDs**

Hideaki Ishido http://orcid.org/0000-0003-2665-0266
Kiyotaka Nakamagoe http://orcid.org/0000-0003-4025-5780
Akiko Ishii http://orcid.org/0000-0002-5719-1106
Tomoyuki Miyamoto http://orcid.org/0000-0002-6535-8260

**REFERENCES**


